Q.1. Draw a Use Case Diagram.

Ans. 
Q.2. Derive Boundary Classes, Controller classes, Entity Classes.
Ans. 
Boundary Classes (Interface & Interaction Layer)
These represent the components that interact directly with external actors such as the customer or admin:
· PaymentPageUI – Interface where the customer selects a payment method
· NetBankingFormUI – Fields for entering bank credentials
· CardEntryForm – Fields for card details (CVV, card number, expiry)
· WalletSelector – Dropdown or radio selection for wallet options
· CashInstructionUI – Displays on-screen instructions for cash handling
Controller Classes (Logic & Coordination Layer)
These classes process requests, enforce business rules, and coordinate flow between boundary and entity layers:
· PaymentController – Central class managing overall payment logic
· TransactionManager – Validates transaction flow based on payment type
· NetBankingProcessor – Coordinates with external bank APIs
· WalletPaymentProcessor – Applies internal wallet logic
· CardAuthorizationProcessor – Handles card payment validation
Entity Classes (Data & Business Object Layer)
These classes hold core business data and are often persisted in databases:
· Customer – Stores customer profile and payment history
· PaymentTransaction – Captures amount, type, status, and timestamp
· BankAccount – For Net Banking payments
· CardDetails – Card number, expiry, holder name
· WalletAccount – Wallet ID, balance, provider name


· PaymentMethod – Enum-like class representing the selected method
· TransactionStatus – Holds final outcome (Success, Failed, Pending)
Q.3. Place these classes on a three tier Architecture.
Ans. 
Presentation Tier (UI Layer):
· PaymentPageUI
· NetBankingFormUI
Business Logic Tier (Application Layer):
· PaymentController
· TransactionManager
Data Tier (Persistence Layer):
· Customer
· PaymentTransaction
· BankAccount
· WalletAccount
Q.4. Explain Domain Model for Customer making payment through Net Banking.
Ans. A domain model is a conceptual representation that defines the structure, relationships and behaviours of entities within a specific problem domain. 
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Q.5. Draw a sequence diagram for payment done by Customer Net Banking.
Ans. A sequence diagram is a type of interaction diagram used in software engineering and systems design to illustrate how processes operate with one another and in what order. 
[image: Enhance the uploaded image to improve clarity and readability.]
Q.6. Explain Conceptual Model for this Case.
Ans. A conceptual model is a high-level representation of a system used to understand, visualize and communicate the essential aspects of a domain.
Purpose
· It provides a clear and simplified view of the domain
· It helps stakeholders to understand system scope and context
Key elements of a conceptual model
1. Entities
· Customer
· Product
· Order
· Payment
2. Attributes
· customerId
· name
· email
· phoneNumber
3. Relationships
· A Customer places an Order
· An Order contains a Product
· A Customer makes a Payment for an Order


Q.7. What is MVC architecture? Explain MVC rules to derive classes from use case diagram and guidelines to place classes in 3-tier architecture.
Ans. The Model–View–Controller (MVC) framework is an architectural design pattern that separates an application into three main logical components; model, view and controller.
1. View:
· Represents the presentation layer of the application
· Responsible for displaying data to users and capturing input
2. Model:
· Represents the business logic and data of the application
· Manages and manipulates data, applying domain rules
3. Controller:
· Acts as an intermediary between view and model
· Handles user input, updates the Model, and decides which view to display
MVC rules to derive classes from use case diagram:
1. Identify External Actors
· These actors interact with the system → they guide the design of Boundary Classes (View Layer)
2. Extract System Actions from Use Cases
· Use cases describe what the system must do → these actions become Controller Classes (Application Logic Layer)
3. Derive Business Objects from Use Case Data
· Look at nouns and key data passed between actors/system → these form Entity Classes (Model Layer)
Example (Net Banking Payment Case) From Use Case: "Customer makes payment via Net Banking"
· Actor → Customer → leads to PaymentPageUI (Boundary class)
· Action → “Initiates Payment” → PaymentController
· Data → “Account Details, Transaction Status” → BankAccount, PaymentTransaction (Entities)
Guidelines to place classes in 3-tier architecture:
In the 3-tier model, classes are distributed across three logical layers:
1. Presentation Tier (UI Layer)
> Contains Boundary Classes These classes interact directly with users or external systems.
· Examples: PaymentPageUI, NetBankingFormUI, LoginScreen
· Display and collect user input
2. Application Logic Tier (Business Layer)
> Contains Controller Classes These classes implement the system’s behavior and rules.
· Examples: PaymentController, TransactionManager, NetBankingProcessor


· Process requests, coordinate between View and Model
3. Data Tier (Model Layer)
> Contains Entity Classes These classes manage system data and business objects.
· Examples: Customer, BankAccount, PaymentTransaction, TransactionStatus
· Typically mapped to database tables or persisted
Q.8. Explain BA contributions in project (Waterfall Model – all Stages).
Ans. 
	Stage
	Activities
	Artifacts and Resources

	Pre-project
	1. Conduct feasibility study
2. Identify stakeholders
3. Draft business case

	· Business Case Document
· SWOT Analysis
· Stakeholder Identification List


	Planning
	1. Define project scope
2. Prepare Work Breakdown Structure
3. Estimate timelines and budget

	· Scope Document
· WBS (Work Breakdown Structure)
· Project Schedule
· Cost Estimate Sheet


	Project initiation
	1. Organize Kick-off Meeting
2. Assign roles and responsibilities
3. Create communication plan

	· Kick-off Agenda
· RACI Matrix
· Communication Plan Document


	Requirements gathering
	1. Interview stakeholders
2. Conduct workshops
3. Document business and functional requirements

	· BRD (Business Requirements Document)
· Workshop Summary
· Use Case Descriptions


	Requirements analysis
	1. Validate requirements
2. Prioritize features
3. Define acceptance criteria

	· Gap Analysis Document
· MoSCoW Prioritization Sheet
· Acceptance Criteria Document


	Design
	1. Create wireframes
2. Define system architecture
3. Model data flows

	· Wireframes (e.g., Balsamiq)
· ER Diagrams
· Data Flow Diagrams (DFD)


	Development
	1. Build application
2. Integrate APIs
3. Conduct unit testing

	· Source Code Repository
· API Specifications
· Unit Test Reports


	Testing
	1. Write test cases
2. Execute functional and regression tests
3. Track bugs

	· Test Case Document
· Bug Log
· Traceability Matrix


	UAT
	1. Stakeholder validation
2. Final refinements
3. Sign-off approval

	· UAT Checklist
· Feedback Logs
· Sign-off Document






Q.9. What is conflict management? Explain using Thomas – Kilmann technique.
Ans. Conflict management is the process of resolving conflicts or disagreements between individuals or groups in a constructive manner.
Thomas Kilmann technique is a widely used tool for assessing conflict resolution styles & guiding individuals in selecting appropriate strategies to manage conflicts.
· 5 steps of conflict management -
1. Identify the conflict.
2. Discuss the details.
3. Agree with the root problem.
4. Check for every possible solution for the conflict.
5. Negotiate the solution to avoid future conflicts.
Q.10. List down the reasons for project failure.
Ans. 
1. Poor Planning
2. Unclear Objectives and Requirements
3. Inadequate Risk Management
4. Poor Communication
5. Scope Creep
6. Lack of Stakeholder Engagement
7. Resource Constraints
8. Technical Challenges
Q.11. List the Challenges faced in projects for BA.
1. Ans. Project Challenges in Real Time
2. Unclear or Changing Requirements
3. Managing Stakeholder Expectations
4. Scope Creep and Scope Management
5. Time and Resource Constraints
6. Quality Assurance and Testing
7. Documentation and Knowledge Management
8. Technology Constraints and Complexity

Q.12.  Write about Document Naming Standards.
Ans. A document numbering standard is a systematic approach to assigning unique identifiers to various documents created and used throughout the development process.
Ex. Suppose we have a project with the ID "PROJ123," and we're working with a Requirements Specification Document.


Project ID: PROJ123 
Document Type: REQ 
Version: 1.0 
Date: 2024-05-26
The document identifier could be: PROJ123-REQ-1.0-2024-05-26
Q.13. What are the Do’s and Don’ts of a Business analyst.
Ans. 
	Sr. No.
	Do’s
	Don’ts

	1.
	Consult an SME for clarifications in requirements.
	Never say NO to the client.

	2.
	Go to the client with a plain mind and no assumptions. Listen carefully and completely until the client is done, then ask your queries.
	There is no word as “By default.”

	3.
	Try to extract maximum leads to the solution from the client himself.
	Never imagine anything in terms of GUI.

	4.
	Concentrate on the important requirements.
	Don’t interrupt the client while he is giving you the problem.

	5.
	Question the existence of existence. Question everything.

	Never try to give solutions to the client straight away based on your previous experience and assumptions.



Q.14. Write the difference between packages and sub-systems.
Ans. 
· Packages: Collection of components which are not reusable in nature. 
                             Ex: Application development companies work on Packages.
· Sub systems: Collection of components which are reusable in nature. 
                          Ex: Product development companies work on Sub systems.
Q.15. What is camel-casing and explain where it will be used.
Ans. Camel-casing is a naming convention used in computer programming. It is used for naming variables, functions, and identifiers.
Example: 
CamelCase: camelCaseExample
In Camel casing, the first word starts with a lowercase letter and each subsequent word begins with an uppercase letter.
Q.16. Illustrate Development server and what are the accesses does business analyst has?
Ans. A development server refers to a dedicated environment or server that is used during the software development process. It provides a platform for developers and testers to build, test and debug applications before they are deployed to a production environment. 


[image: ]
Development server is basically divided into two parts; one is for documents and the other one is for technology. Documents is further divided into two parts; one is for public and the other one is for protected. 
Technology is divided into 3 parts; coding, testing and database. These are logical partitions not physical servers because coding can have 2 to 3 different servers. For testing as well, we can have 2 to 3 different servers. For database, we can have 2 to 3 different servers. 
The IT company for example, gets a project PQ786. For this project, a slice of server is given that means a part of public documents area, a part of protected area, a part of coding area, a part of testing area and   a part of DB will be given. 
The BA will be given access to the public documents area, coding area and testing area and will not have access to the protected area or the database.
Q.17. What is Data Mapping?
Ans. Data mapping is the process of connecting data from one source to another. It's like creating a guide or map that shows how data in one place corresponds to data in another place. This is especially important when you're moving data between different systems or databases to ensure that the data stays consistent and accurate.
Q.18. What is API. Explain how you would use API integration in the case of your application Date format is dd-mm-yyyy and it is accepting some data from Other Application from US whose Date Format is mm-dd-yyyy
Ans. 
· An API, or Application Programming Interface, is a set of rules and tools that allows different software applications to communicate with each other.
· It defines the methods and data formats that applications can use to request and exchange information.
API integration in our application (Date Format Scenario)
Step-by-Step Strategy
1. Receive API Payload
· Your system receives JSON/XML data via API
· Example: "transactionDate": "07-04-2025" (from US system)
2. Detect Format
· Use a date parser or regex to identify if the incoming format is mm-dd-yyyy
· Validate using known patterns or headers


3. Convert Format
· Use backend logic (e.g., Java, Python, or JavaScript) to convert:
from datetime import datetime
us_date = "07-04-2025"
parsed_date = datetime.strptime(us_date, "%m-%d-%Y")
indian_format = parsed_date.strftime("%d-%m-%Y")
print(indian_format)  # Output: 04-07-2025
4.   Store or Display
· Save the converted date in your database using dd-mm-yyyy
· Display it in UI or use it for further processing
5.   Document Expectations
· In your API spec, clearly mention accepted formats
· Optionally, use ISO 8601 (yyyy-mm-dd) as a neutral format for consistency
Tools & Techniques:-
· Middleware or API Gateway: Can intercept and transform date formats
· Custom Deserializers: In frameworks like Spring Boot or .NET, use JsonConverter or ModelBinder
· Validation Libraries: Use libraries like moment.js, date-fns, or SimpleDateFormat in Java
Example in Capstone Context
If our Net Banking app receives:
Json
{"customerId": "C123", "transactionDate": "07-04-2025"}
We would:
· Detect it as mm-dd-yyyy
· Convert to 04-07-2025
· Store it as dd-mm-yyyy in your DB
· Display it correctly in the UI
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